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Safety messages

NOTICE

Read this manual before working with the product. For personal and system safety, and for optimum product performance,
ensure you thoroughly understand the contents before installing, using, or maintaining this product.

For technical assistance, contacts are listed below:

Customer Central

Technical support, quoting, and order-related questions.

• United States - 1-800-999-9307 (7:00 am to 7:00 pm CST)

• Asia Pacific- 65 777 8211

North American Response Center

Equipment service needs.

• 1-800-654-7768 (24 hours a day — includes Canada)

• Outside of these areas, contact your local Emerson representative.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained personnel, in accordance with the
applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

 WARNING

Physical access

Unauthorized personnel may potentially cause significant damage to and/or misconfiguration of end users’ equipment. This could
be intentional or unintentional and needs to be protected against.

Physical security is an important part of any security program and fundamental to protecting your system. Restrict physical access
by unauthorized personnel to protect end users’ assets. This is true for all systems used within the facility.

 CAUTION

Hot surfaces

The transmitter and process seal may be hot at high process temperatures. Allow to cool before servicing.
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1 Introduction

1.1 Using this manual
The sections in this manual provide information on installing, operating, and maintaining
the Rosemount™ 1408H Level Transmitter – Non-Contacting Radar.

The sections are organized as follows:

Transmitter overview provides an introduction to theory of operation, a description of the
transmitter, information on typical applications, and process characteristics.

Mechanical installation contains mechanical installation instructions.

Electrical installation contains electrical installation instructions.

Configuration provides instructions on configuration of the transmitter.

Operation and maintenance contains operation and maintenance techniques.

Service and troubleshooting provides troubleshooting techniques for the most common
operating problems.

Specifications and reference data supplies reference and specification data.

Product certifications contains approvals and certifications information.

Configuration parameters provides extended information about the configuration
parameters.

1.2 Open source licenses
This device uses open source software. Further information can be found in the
License Information Document available at Emerson.com/Rosemount.

1.3 Product recycling/disposal
Recycling of equipment and packaging should be taken into consideration and disposed of
in accordance with local and national legislation or regulations.

Related information

Service support
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2 Transmitter overview

2.1 Measurement principle
The Rosemount 1408H is a transmitter for continuous level measurements using fast-
sweep Frequency Modulated Continuous Wave (FMCW) technology.

The transmitter continuously emits signal sweeps with a constantly varying frequency
towards the product surface. Since the transmitter continuously changes the frequency of
the transmitted signal, there will be a difference in frequency between the transmitted
and the reflected signals (see Figure 2-1).

The frequency of the reflected signal is subtracted from the frequency of the signal
transmitted at that moment, resulting in a low frequency signal which is proportional to
the distance to the product surface. This signal is further processed to obtain fast, reliable,
and highly accurate level measurements.

Figure 2-1: FMCW-method
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2.2 Process characteristics

2.2.1 Dielectric constant
A key parameter for measurement performance is reflectivity. A high dielectric constant of
the media provides better reflection and enables a longer measuring range.
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2.2.2 Foam and turbulence
Foaming liquids or turbulence may cause weak and varying surface echo amplitudes.
Surface turbulence is not normally a problem unless it is excessive.

Measurement in foamy applications depends largely on the foam properties. When the
foam is light and airy, the actual product level is measured. For heavy and dense foam, the
transmitter may measure the level of the foam’s upper surface.

2.3 Vessel characteristics

2.3.1 In-tank obstructions
The transmitter should be mounted so that objects such as heating coils, ladders, and
agitators are not in the radar signal path. These objects may cause false echoes resulting in
reduced measurement performance. However, the transmitter has built-in functions
designed to reduce the influence from disturbing objects where such objects cannot be
totally avoided.

Vertical and inclined structures cause minimal effect since the radar signal is scattered
rather than directed back to the antenna.

2.4 Application examples
Non-contacting radar technology is ideal for applications in the hygienic industry as it is
maintenance-free, has a top-down installation that reduces the risk of leakages, and is
unaffected by process conditions such as density, viscosity, temperature, pressure, and
pH.

The Rosemount 1408H uses Frequency Modulated Continuous Wave (FMCW) technology
and smart algorithms to maximize measurement accuracy and reliability, even in small
tanks and challenging fast-filling vessels.

Storage tank

Gain insights into your tank and ensure production runs smoothly without interruption.
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Mixing tanks

Ensure correct filling and storage levels in tanks with agitators.

Batch filling

Optimize the batch filling process.

CIP process

Reliable level measurement during and after cleaning, plus optimization of cleaning agent
storage.
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2.5 Components of the transmitter
Figure 2-2: Components
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A. M12 connector (A-coded)
B. Transmitter housing (polished stainless steel)
C. Wrench size: 39 mm
D. DIN 3869 profile ring
E. ISO 228/1-G1 thread
F. Antenna (PTFE sealing)
G. Hygienic adapter O-ring
H. Hygienic process connection adapter

Figure 2-3: O-ring and Profile Ring
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A. DIN 3869 profile ring
B. Hygienic adapter O-ring

Related information

Dimensional drawings
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2.6 Easy integration with IO-Link
The Rosemount 1408H provides both conventional 4-20 mA and digital switch outputs,
enabled by IO-Link connectivity. This supports easy integration into any automation
system.

Each IO-Link system consists of an IO-Link master and one or more IO-Link devices (sensors
and actuators). The connection between the master and the device is established via
unshielded standard cables using standard connectors such as M12. Process data, events
and parameters are transferred to the master via IO-Link. The IO-Link master then
transfers the data to the controller (PLC) and its fieldbus or industrial ethernet network.

Figure 2-4: Example of an IO-Link System
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A. Industrial ethernet
B. Programmable logic controller (PLC)
C. Industrial Fieldbus
D. IO-Link master
E. IO-Link devices
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3 Mechanical installation

3.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

3.2 Installation considerations
Before installing the transmitter, follow recommendations for mounting position,
sufficient free space, nozzle requirements, etc.
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3.2.1 Mounting position
When finding an appropriate location on the tank for the transmitter, the conditions of the
tank must be carefully considered.

Consider the following guidelines when mounting the transmitter:

• For optimal performance, the transmitter should be installed in locations with a clear
and unobstructed view of the product surface.

• The transmitter should be mounted with as few internal structures as possible within
the signal beam.

• Do not mount close to or above the inlet stream.

• Do not position the transmitter directly over a side manway door.

• Multiple Rosemount 1408H transmitters can be used in the same tank without
interfering with each other.

Figure 3-1: Recommended Mounting Position

L

3.2.2 Free space requirements
If the transmitter is mounted close to a wall or other tank obstruction such as heating coils
and ladders, noise might appear in the measurement signal. See Table 3-1 for
recommended clearance.

Figure 3-2: Free Space Requirements

L
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Table 3-1: Distance to Tank Wall (L)

Minimum Recommended

8 in. (200 mm) ½ of tank radius

3.2.3 Inclination
The transmitter should be mounted vertically to ensure a good echo from the product
surface. See Figure 3-3 for recommended maximum inclination.

Figure 3-3: Inclination

90°

Max. 3°

3.2.4 Non-metallic tanks
Nearby objects outside the tank may cause disturbing radar echoes. Wherever possible,
the transmitter should be positioned so that objects close to the tank are kept outside the
signal beam.

Related information

Telecommunication compliance
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3.2.5 Beam angle and beam width
The transmitter should be mounted with as few internal structures as possible within the
signal beam.

Figure 3-4: Beam Angle and Beam Width

D

W

Beam angle (α)

10°

Beam width

See Table 3-2 for beam width at different distances.

Table 3-2: Beam Width

Distance (D) Beam width (W)

6.6 ft. (2 m) 1.2 ft. (0.4 m)

13.1 ft. (4 m) 2.3 ft. (0.7 m)

19.7 ft. (6 m) 3.5 ft. (1.1 m)

26.2 ft. (8 m) 4.6 ft. (1.4 m)

32.8 ft. (10 m) 5.8 ft. (1.8 m)
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3.2.6 Nozzle requirements
To allow the microwaves to propagate undisturbed, the nozzle dimensions should be kept
within the specified limits as given in Table 3-3. The inside of the nozzle must be smooth
(i.e. avoid bad welding, rust, or deposit).

Figure 3-5: Mounting in Nozzles

D

H

Table 3-3: Nozzle Requirements

Nozzle diameter (D) Maximum nozzle height (H)

1 in. (25 mm) 3.9 in. (100 mm)

1.5 in. (40 mm) 5.9 in. (150 mm)

2 in. (50 mm) 7.9 in. (200 mm)

3 in. (80 mm) 11.8 in. (300 mm)

4 in. (100 mm) 15.8 in. (400 mm)

6 in. (150 mm) 23.6 in. (600 mm)

For 3-A® applications, the allowed nozzle height is further restricted to ensure cleanability.

Table 3-4: Nozzle Height in 3-A Applications

Standard Maximum nozzle height (H)

3-A Must not exceed 2 x nozzle diameter (D) nor 5 in. (127 mm)
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3.2.7 Mounting onto a threaded connection
Refer to Figure 3-6 for the required thread engagement length at the customer G1 process
connection.

Figure 3-6: Thread Engagement Length

A A

A. 0.35 to 0.63 in. (9 to 16 mm)

Related information

Dimensional drawings

3.2.8 Instructions for hygienic installations
To conform with applicable hygienic standards and food and beverage legislation and
regulations, the Rosemount 1408H must be:

• Installed in a closed tank.

• Installed with hygienic adapter and O-ring.

It is the responsibility of the user to ensure:

• The materials listed in Materials of construction are suitable for the media and
cleaning/sanitizing processes.

• The installation of the transmitter is drainable and cleanable.

• That the joint/clamping between the transmitter and the nozzle is compatible with the
tank pressure and media.

• That for the application a suitable M12 connector is used and with appropriate ingress
protection.

Related information

Materials of construction

Specific requirements for 3-A®

• The hygienic adapter must be 3-A certified and approved for use with the transmitter.

• Fittings and connections must comply with the requirements of 3-A Sanitary Standard
63-.

• On the “product contact side”, correct gasket variants shall be used and be made of 3-
A compliant product contact material.

Mechanical installation Reference Manual
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Clean-In-Place (CIP)
Withstands cleaning routines up to 194 °F (90 °C)

Steam-In-Place (SIP)
Withstands cleaning routines up to 284 °F (140 °C)

3.2.9 Hygienic adapter O-ring
The adapter comes with an EPDM O-ring. More O-rings are available as accessories.

Related information

Product Data Sheet

3.3 Mounting preparations

3.3.1 Remove the protective cap
The protective cap protects the PTFE sealing from impacts during transport and storage.

Procedure

Before installing, carefully remove the protective cap.

Note
Be careful not to scratch or otherwise damage the PTFE sealing.
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3.3.2 Tri Clamp, dairy coupling, and VARIVENT®

Install the adapter

Procedure

1. Place the O-ring in the groove of the transmitter.

Note
Be careful not to scratch or otherwise damage the PTFE sealing.

2. Apply lubricating paste on the transmitter thread.

Note
The paste must be approved for the application and compatible with the
elastomers used.

3. (Only for DIN 11851) Slide the coupling nut up over the bottom of the transmitter.
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4. Screw the adapter onto the transmitter until it is hand-tight.

5. Secure the transmitter and adapter using a vise.

 CAUTION

Do not over-tighten the vise as it might damage the adapter.

6. Tighten the transmitter to the recommended torque.

Note
Further tightening may affect the sealing.

39 mm
Torque 310 in-lb (35 N-m)
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3.3.3 Weld-in adapter

Mount the welding mandrel
The welding mandrel absorbs heat and can prevent warping during installation of the
weld-in adapter.

Prerequisites

 CAUTION

While welding, the weld-in adapter and mandrel can get extremely hot. To prevent burns,
allow the components to cool before disassembling the weld-in adapter and mandrel
assembly.

Procedure

1. Hand-tighten the weld-in adapter.

2. Insert the bolt through mandrel opening.

3. Mount the counter plate.
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4. Tighten the nut.

16 mm

Postrequisites

1. Install the weld-in adapter.

2. Allow the weld and mandrel components to cool, then remove the mandrel
components from the weld-in adapter.

Related information

Install the weld-in adapter

Install the weld-in adapter

Prerequisites

After welding, allow the adapter to cool before installing. Do not weld the adapter to the
container or pipe with the transmitter connected.

Procedure

1. Weld the adapter.

Note
While welding, prevent the adapter from warping.

a) Fix the adapter in several spots with a sufficient adhesive force.

Apply the fixing points at equal distances opposite each other.
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b) Apply the welding seams between the fixing points opposite each other.

Ensure sufficient and even distance between the individual sections to avoid
glowing through or warping of the adapter caused by overheating.

2. Allow the adapter to cool.

3. If used, remove the welding mandrel.

4. Remove deposits from the thread.
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3.4 Mount transmitter on tank

3.4.1 Mount the Tri Clamp version
Procedure

1. Place a suitable gasket on top of the tank flange.

2. Lower the transmitter into the nozzle.

Note
Be careful not to scratch or otherwise damage the PTFE sealing.

3. Tighten the clamp to the recommended torque (see the manufacturer’s instruction
manual).
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3.4.2 Mount the dairy coupling (DIN 11851)
Procedure

1. Place a suitable gasket on top of the tank flange.

2. Lower the transmitter into the nozzle.

Note
Be careful not to scratch or otherwise damage the PTFE sealing.

3. Tighten the lock nut to the recommended torque (see the manufacturer’s
instruction manual).
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3.4.3 Mount the VARIVENT® version
Procedure

1. Mount a suitable O-ring on the adapter.

2. Lower the transmitter into the nozzle.

Note
Be careful not to scratch or otherwise damage the PTFE sealing.

3. Tighten the clamp to the recommended torque (see the manufacturer’s instruction
manual).
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3.4.4 Mount on a threaded connection
Procedure

1. Apply lubricating paste on the transmitter thread.

Note
The paste must be approved for the application and compatible with the
elastomers used.

2. Mount the transmitter on the tank.

39 mm
Torque 310 in-lb (35 N-m)

Note
Be careful not to scratch or otherwise damage the PTFE sealing.
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3.4.5 Mount the weld-in adapter version
Procedure

1. Place the O-ring in the groove of the transmitter.

Note
Be careful not to scratch or otherwise damage the PTFE sealing.

2. Apply lubricating paste on the transmitter thread.

Note
The paste must be approved for the application and compatible with the
elastomers used.

3. Tighten the transmitter to the recommended torque.

39 mm
Torque 310 in-lb (35 N-m)

Note
Over tightening the transmitter can impair the seal. If the sealing areas are
damaged, replace the O-ring or the entire process connector.

Reference Manual Mechanical installation
00809-0100-4480 May 2021

Reference Manual 29



Mechanical installation Reference Manual
May 2021 00809-0100-4480

30 Rosemount 1408H Level Transmitter



4 Electrical installation

4.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

4.2 Prepare the electrical connections

4.2.1 Connector type
M12 (A-coded)

4.2.2 Power supply
The transmitter operates on 18-30 Vdc at the transmitter terminals.

Related information

Load limitations
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4.2.3 Outputs
The transmitter provides two configurable outputs:

Output 1 Digital output / IO-Link mode

Output 2 Digital output or active 4-20 mA analog output

4.2.4 Internal power consumption
< 2 W (normal operation at 24 Vdc, no outputs)

< 3.6 W (normal operation at 24 Vdc, digital and analog outputs active)

4.2.5 Wiring diagram

Figure 4-1: Connection
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Table 4-1: Pin Assignment

Pin Wire color(1) Signal

1 BN Brown L+ 24 V

2 WH White OUT2 Digital output or active 4-20 mA analog
output

3 BU Blue L- 0 V

4 BK Black OUT1/IO-Link Digital output or IO-Link mode

(1) According to IEC 60947-5-2.
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Figure 4-2: Example Circuits
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A. 2 x Digital output PnP
B. 2 x Digital output NpN
C. 1 x Digital output PnP / 1 x Analog output
D. 1 x Digital output NpN / 1 x Analog output

Related information

Outputs
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4.3 Power up transmitter
Prerequisites

Procedure

1.  Verify the power supply is disconnected.

2. Insert the M12 connector and screw tight.

See the manufacturer’s instruction manual for recommended torque.

3. Connect the power supply.

Related information

Ingress protection
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5 Configuration

5.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

5.2 Overview
This chapter provides information about configuration and configuration tools. Appendix
Configuration parameters provides extended information about the configuration
parameters.
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5.3 Connect the transmitter to the IO-Link
IO-Link devices can be set using an IO-Link USB Communicator, through the IO-Link
master, or via the PLC.

Procedure

Start the configuration software and connect the transmitter.

Figure 5-1: Connection via the IO-Link USB Communicator

Figure 5-2: Connection via the IO-Link Master

Figure 5-3: Connection via the PLC

5.4 Get started with your preferred configuration
tool

5.4.1 IO-Link configuration tools
Examples:

• Rosemount IO-Link Assistant (available as accessory)

• FDT® frame applications, e.g. PACTware

5.4.2 Rosemount IO-Link Assistant

Get the latest IODD files
The Rosemount IO-Link Assistant software checks and lets you download the latest IODDs
for your device catalog.

Prerequisites

For an online update, an internet connection is required.
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Procedure

1. Click the  icon.
The Device description files (IODD): download and install window opens.

2. In the Vendor list, select Rosemount Inc., and then select the check box for the
devices to be installed/updated.

Alternatively, browse to an already downloaded IODD zip file, and select Open.

3. Select OK.

5.4.3 FDT®/DTM framework

Download the IODD file

Procedure

1. Download the IODD from the IODDFinder portal at Ioddfinder.io-link.com.

2. Unzip the IODD package.

Integrate IODDs into an FDT®/DTM framework
An IODD DTM Interpreter is required to integrate IODDs into an FDT/DTM environment
(e.g PACTware).

Prerequisites

The IODD DTM Interpreter is usually included in the FDT/DTM software installation
package. It can also be downloaded from Emerson.com/Rosemount1408H.

Procedure

1. Start the IODD DTM Interpreter software.
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2. Select Add IODD.

3. Browse to the IODD file (.xml) and select Open.

4. Start the configuration tool and update the device catalog.

Need help?
If the new DTM is not added automatically at start-up, then select View → Device
Catalog → Update Device Catalog.
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5.5 Perform the basic setup

5.5.1 Set the engineering units
Procedure

1. Under Menu, select Parameter → Basic Setup.

2. In the Engineering Units list, select Metric or Imperial.

Option Description

Metric Length: m

Temperature: °C

Imperial Length: in.

Temperature: °F

3. Select Write to device.

5.5.2 Enter the reference height
Procedure

1. Under Menu, select Parameter → Basic Setup.

2. Enter the Reference Height.

3. Select Write to device.

Related information

Reference height

5.5.3 Configure the analog output
The transmitter can be set to output the level as a 4-20 mA signal.

Procedure

1. Under Menu, select Parameter → Basic Setup.

2. In the OUT2 Configuration list, select Analog Output 4-20 mA.

3. Select OUT2 → Analog Output 2.

4. Enter the desired Upper Range Value (20 mA).

5. Enter the desired Lower Range Value (4 mA).

6. In the Alarm Mode list, select Low Alarm or High Alarm.

7. Select Write to device.

Related information

Analog output
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5.5.4 Configure the digital output
The transmitter can be set to output a switching signal for high and low level limits (using
the same pin).

Procedure

1. Under Menu, select Parameter → Basic Setup.

2. In the OUT1 Configuration or OUT2 Configuration list, select Digital Output Normally
Open.

3. In the Digital Outputs P-n list, select PnP or nPn.

4. Select Digital Output 1 or Digital Output 2.

5. Set the alarm parameters as desired.

6. Select Write to device.

Related information

Digital output
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6 Operation and maintenance

6.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.

6.2 View measurement data and events
The dashboard in Rosemount IO-Link Assistant displays the measured values, device
status, switching status for digital output (on/off), and events. The measured values and
switching states are visualized in a graph over a defined period of time.

Procedure

From the Overview screen, select Dashboard.
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Figure 6-1: Dashboard

Need help?
Select the Help  button for more information on the features and capabilities.

6.2.1 Measurement variables
Variable Description

Level The current level measurement value (from the zero level to the product
surface).

Distance The distance from the transmitter reference point to the surface.

Signal strength The reflected signal strength from the surface.

Electronics
temperature

The current temperature at the electronics.

Min electronics
temperature

The measured minimum electronics temperature.

Max electronics
temperature

The measured maximum electronics temperature.

6.2.2 Interpret measurement status
A “Good” or “Bad” status next to a value is an indication of the reliability or integrity of the
data being received, not an indication of whether or not the value is within the configured
upper or lower ranges. A value that triggers an alert, such as a high or low temperature
indication, will change the overall status of the device, but the measurement might still be
indicated as “Good” if the reliability of the data is good.
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6.3 Enter the demonstration mode
In this mode, the signal processing method is optimized for demo situations when
simulating a product surface with, for example, a measurement target plate.

Note
This mode is intended for demonstration purposes only, and should not be used for
normal operations.

Prerequisites

The demonstration mode will reset the following parameters to factory settings:

• Measurement recovery time

• Negative level

• Damping value

When returning to Default Mode, you will therefore need to reconfigure these parameters
(if desired).

Procedure

1. Under Menu, select Parameter → Service Tools → Application Mode.

2. Select Enter Demonstration Mode.

Postrequisites

1. Select Exit Demonstration Mode to return to normal operation (Default Mode).

2. Verify that the Application Mode is set to Default Mode.

6.4 Replacing the O-ring
The process wetted O-ring should be checked periodically. Replace with O-ring designed
for Rosemount 1408H if there are any signs of damage.

Procedure

1. Secure the transmitter and adapter using a vise.
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2. Unscrew the adapter from the transmitter.

39 mm

3. Remove the O-ring using a suitable non-metallic tool.

Note
Be careful not to scratch any of the surfaces.

4. If needed, clean the sealing areas.

Related information

Install the adapter
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7 Service and troubleshooting

7.1 Safety messages
Instructions and procedures in this section may require special precautions to ensure the
safety of the personnel performing the operations. Information that potentially raises
safety issues is indicated by a warning symbol ( ). Refer to the following safety messages
before performing an operation preceded by this symbol.

 WARNING

Failure to follow safe installation and servicing guidelines could result in death or
serious injury.

Ensure the transmitter is installed by qualified personnel and in accordance with applicable
code of practice.

Inspection and maintenance of this equipment shall be carried out by suitably trained
personnel, in accordance with the applicable standards and code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the
protection provided by the equipment.

Repair, e.g. substitution of components, etc. may jeopardize safety and is under no
circumstances allowed.

 WARNING

Process leaks could result in death or serious injury.

Handle the transmitter carefully.

Install and tighten process connectors before applying pressure.

Do not attempt to loosen or remove process connectors while the transmitter is in service.
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7.2 Diagnostic messages

7.2.1 Device hardware fault – Device exchange
Alarm classification

Device status Failure

Class Error

Possible cause

An electronics error has occurred.

Recommended actions

1. Restart the device.

2. If the condition persists, replace the device.

Related information

Perform a device reset

7.2.2 Device software fault – Check firmware revision
Alarm classification

Device status Failure

Class Error

Possible cause

The software has detected an internal error.

Recommended actions

1. Restart the device.

2. Restore default settings and reconfigure the device.

3. If the condition persists, replace the device.

Related information

Perform a device reset
Restore to factory settings
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7.2.3 General power supply fault – Check availability
Alarm classification

Device status Failure

Class Error

Possible cause

Power supply drops below 18 Vdc during transmitter start-up.

Recommended actions

Verify voltage is 18-30 Vdc at the transmitter terminal.

7.2.4 Parameter error – Check data sheet and values
Alarm classification

Device status Failure

Class Error

Possible cause

The device has detected a configuration error.

Recommended actions

1. If analog output is used, check Upper and Lower Range Values.

2. If digital output is used, check High and Low Alarm Set Points.

3. If condition persists, restore default settings and reconfigure the device.

Related information

Upper/lower range value
Alarm set points
Restore to factory settings
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7.2.5 Device memory failure – Restore default settings
Alarm classification

Device status Failure

Class Error

Possible cause

Configuration data has been corrupted, for example, due to a power loss during writing.

Recommended actions

1. Restore default settings, restart device, and reconfigure the device.

2. If the condition persists, replace the device.

Related information

Restore to factory settings
Perform a device reset

7.2.6 Simulation active – Check operational mode
Alarm classification

Device status Functional check

Class Warning

Possible cause

The device is in simulation mode and is not reporting actual information.

Recommended actions

1. If this behavior is not desired, stop simulation mode.

2. If the condition persists, restart the device.

Related information

Use the simulation mode
Perform a device reset
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7.2.7 Level measurement lost – Check application
Alarm classification

Device status Failure

Class Error

Possible cause

No valid level reading. Reasons may be multiple:

• No valid surface echo peak in the measuring range

• Incorrect device configuration

Recommended actions

1. Analyze the Echo Peaks and check device configuration, especially General
Threshold.

2. Check device physical installation (for instance antenna contamination).

3. Consider increasing Measurement Recovery Time parameter for intermittent
conditions.

4. Restore default settings, restart device, and reconfigure the device.

5. If the condition persists, replace the device.

Related information

Analyze the echo peaks
Adjust the general threshold
Measurement recovery time
Restore to factory settings
Perform a device reset
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7.2.8 Device temperature over-run – Clear source of heat
Alarm classification

Device status Out of specification

Class Warning

Possible cause

The electronics temperature is outside the operating range.

Recommended actions

1. Verify ambient temperature is within the operating range.

2. Clear source of heat.

Related information

Ambient temperature

7.2.9 Device temperature under-run – Insulate device
Alarm classification

Device status Out of specification

Class Warning

Possible cause

The electronics temperature is outside the operating range.

Recommended actions

1. Verify ambient temperature is within the operating range.

2. Insulate device.

Related information

Ambient temperature
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7.2.10 Short circuit – Check installation
Alarm classification

Device status Out of Specification

Class Error

Possible cause

Short circuit on the digital output.

Recommended actions

Check cable and connections.

7.2.11 Primary supply voltage over-run – Check tolerance
Alarm classification

Device status Out of specification

Class Warning

Possible cause

Supply voltage is too high.

Recommended actions

Verify voltage is 18-30 Vdc at the transmitter terminal.

7.2.12 Primary supply voltage under-run – Check tolerance
Alarm classification

Device status Out of specification

Class Warning

Possible cause

Supply voltage is too low.

Recommended actions

Verify voltage is 18-30 Vdc at the transmitter terminal.
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7.2.13 Maintenance required - Cleaning
Alarm classification

Device status Maintenance required

Class Notification

Possible cause

Product build-up on the antenna.

Recommended actions

Clean the antenna.

Use a damp cloth and a mild cleaning agent suitable for the media and wetted parts of
the transmitter.

Note
Take care not to scratch the PTFE sealing surfaces.

Related information

Material exposed to tank atmosphere
Components of the transmitter

7.2.14 Max EEPROM write cycles expired – Check master and
restart the device
Alarm classification

Device status Maintenance required

Class Warning

Possible cause

Frequent writing of parameters from master to device.

Recommended actions

1. Check the master configuration.

2. Restart the device.

3. If error persists, contact your local Emerson representative.

Related information

Perform a device reset
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7.3 Troubleshooting incorrect level readings

7.3.1 Reported level is too high or low

Figure 7-1: Symptom
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Possible cause

Incorrect tank geometry configuration.

Recommended actions

• Verify the tank geometry parameters are configured correctly (especially the
Reference Height).

• Analyze the Echo Peaks and check General Threshold.

• Restore default settings and reconfigure the device.

Related information

Reference height
Analyze the echo peaks
Adjust the general threshold
Restore to factory settings
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7.3.2 Level is stuck in measuring range

Figure 7-2: Symptom
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Possible cause

Disturbing object in the tank.

Recommended actions

• Analyze the Echo Peaks and check General Threshold.

• Remove the disturbing object.

• Rotate the transmitter in steps of about 15 degrees. After each step, check if
impact of disturbing echoes is decreased by analyzing the Echo Peaks.

15°

• Put an inclined metal plate on top of the disturbing object.

• Move the transmitter to another position.

Related information

Analyze the echo peaks
Adjust the general threshold
Mounting position
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7.3.3 Level is stuck in full tank

Figure 7-3: Symptom
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Possible cause

Disturbing object near the antenna.

Recommended actions

• Analyze the Echo Peaks and check General Threshold.

• Increase the Upper Null Zone.

• Remove the disturbing object.

• Move the transmitter to another position.

Possible cause

Product build-up on the antenna.

Recommended actions

• Clean the antenna.

Related information

Analyze the echo peaks
Adjust the general threshold
Change the upper null zone
Mounting position
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7.3.4 Level value drops when close to antenna
Level value drops to a lower value when product surface is close to antenna.

Figure 7-4: Symptom
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Possible cause

Product surface is within the Upper Null Zone and a disturbance echo is interpreted as the
product surface.

Recommended actions

• Check the setting of the Upper Null Zone.

Related information

Change the upper null zone
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7.3.5 Measured level fluctuates

Figure 7-5: Symptom
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Possible cause

Excessive foaming or turbulence.

Recommended actions

• Under turbulent conditions with low level rates, consider increasing the Damping
value.

Related information

Damping value
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7.3.6 Measured level is occasionally unstable

Figure 7-6: Symptom

A

B

C

D

A. Level
B. Time
C. Actual level
D. Reported level

Possible cause

The product surface is close to a suppressed false echo.

Recommended actions

• If possible, remove the disturbing object.

Related information

Analyze the echo peaks
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7.3.7 Lagging of measured level
Symptom

Measured level lags during rapid level changes.

Figure 7-7: Symptom
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Possible cause

Damping value is set too high.

Recommended actions

• If there is a problem with lag during rapid level changes, consider decreasing the
Damping value.

Related information

Damping value
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7.3.8 Incorrect level at 100% (20 mA)
Symptom

Measured level is correct at 0% (4 mA) but incorrect at 100% (20 mA).

Figure 7-8: Symptom
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Possible cause

Upper Range Value is not set correctly.

Recommended actions

• Check that the Upper Range Value matches the 100% (20 mA) level in the tank.

Related information

Upper/lower range value
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7.3.9 Incorrect level when product surface is above 50%
Symptom

The reported level is incorrect when the product surface is above the 50% level.

Figure 7-9: Symptom
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Possible cause

A strong double bounce echo is interpreted as the product surface.

Recommended actions

• Move the transmitter to another position.

Related information

Mounting position
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7.3.10 Dropping of level close to tank bottom
Symptom

Measured value drops to zero level in the tank bottom region.

Figure 7-10: Symptom
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Possible cause

Transmitter has locked on a strong tank bottom echo.

Recommended actions

• Verify the Reference Height is configured correctly.

Related information

Reference height
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7.3.11 Level measurement is lost in an empty tank
The transmitter reports "Level measurement lost" in an empty tank after closing the side
manway door.

Figure 7-11: Symptom
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Possible cause

When the manway door is opened inward, it generates a disturbance echo which is
interpreted as the product surface echo. After closing the door, the echo is lost and the
transmitter reports "Level measurement lost". The message is cleared when start filling the
tank.

Recommended actions

• Before opening the manway door, disconnect power to the transmitter.

• After closing, restart the device.

• Move the transmitter to another position.

Related information

Mounting position
Perform a device reset
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7.3.12 Alarm mode close to tank bottom
Symptom

When the product surface is near the sloped tank bottom, the transmitter enters alarm
mode.

Figure 7-12: Symptom
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Possible cause

Reduction of projected surface area close to sloping tank bottom.

Recommended actions

• Verify the tank geometry parameters are configured correctly (especially the
Reference Height and Bottom Offset).

Related information

Reference height
Bottom offset

7.4 Managing disturbance echoes
There are two general methods for managing disturbance echoes:

• Set general threshold to filter out weak disturbance echoes and noise.

• Increase the Upper Null Zone to block out disturbance echoes at the top of the tank.

Service and troubleshooting Reference Manual
May 2021 00809-0100-4480

64 Rosemount 1408H Level Transmitter



7.4.1 Adjust the general threshold
If necessary, the general threshold value can be increased if a disturbance echo is
interpreted as the product surface. Alternatively, a lower threshold may be required to
handle weak surface echoes (e.g. due to excessive foaming or turbulence).

Prerequisites

The general threshold is set at factory for optimum performance and should not normally
need an adjustment.

Before changing the factory default value, study the position and amplitude of the
different echo peaks.

Procedure

1. Under Menu, select Parameter → Advanced Setup.

2. In the General Threshold box, enter the desired value.

3. Select Write to device.

Related information

Analyze the echo peaks
General threshold

7.4.2 Change the upper null zone
The Upper Null Zone defines a zone close to the transmitter where echoes are ignored.
This zone can be extended to block out disturbing echoes at the top of the tank.

Prerequisites

Note
Make sure the Upper Range Value (100%/20 mA) value is below the Upper Null Zone.
Measurements are not performed within the Upper Null Zone.

Procedure

1. Identify desired Upper Null Zone by analyzing the echo peaks.

a) Under Menu, select Diagnosis → Echo Peaks.

b) View the echo peaks to find out if there are disturbing echoes close to tank
top.

2. Set the desired Upper Null Zone value.

a) Under Menu, select Parameter → Geometry → Advanced.

b) Enter the desired Upper Null Zone value.

c) Select Write to device.
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Figure 7-13: Upper Null Zone
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Related information

Upper null zone

7.5 Service and troubleshooting tools

7.5.1 Analyze the echo peaks
Measurement problems can be understood by studying the position and amplitude of the
different peaks.

Procedure

Under Menu, select Diagnosis → Echo Peaks.
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Echo peaks
See Table 7-1 for a list of possible echo peaks.

Table 7-1: Echo Peak Types

Type Description

Surface Echo tracked as the current surface echo

Unknown Echo identified as unknown (can be a surface candidate)

Suppressed Echoes that are identified but suppressed by the device

Tank bottom echo Echo considered as an echo from the tank bottom

7.5.2 Perform a device reset
The function is used to reset/restart the electronics without re-cycling the power.

Procedure

1. Under Menu, select Parameter → Service Tools → Maintenance.

2. Select Device Reset.

7.5.3 Restore to factory settings
This function restores the transmitter to factory settings (user configuration is
overwritten).

Procedure

1. Under Menu, select Parameter → Service Tools → Maintenance.

2. Select Restore Factory Settings.

7.5.4 Use the simulation mode
It is possible to set the level to a simulated value for testing purposes. The simulated value
affects both digital and analog output.

Procedure

1. Under Menu, select Parameter → Service Tools → Simulation.

2. In the Simulated Level box, enter the desired value.

3. Select Write to device.

4. Select Start simulation (60 min).
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7.5.5 Calibrate analog out
Use this function to calibrate the analog output by comparing the actual output current
with the nominal 4 mA and 20 mA currents. Calibration is done at factory and the analog
output does not normally need to be recalibrated.

Prerequisites

Connect a calibrated ampere meter to the analog output loop.

Procedure

1. Under Menu, select Parameter → Service Tools → Analog Out Calibration.

2. Perform the calibration of 4 mA.

a) Select Enter 4 mA Fixed Current Mode to set the analog out to 4 mA.

b) Measure the analog output with the ampere meter.

c) In the 4 mA Measured Current box, enter the measured current.

d) Select Write to device.

e) Select Calibrate 4 mA.

f) Measure the analog output with the ampere meter and verify it is within
4±0.01 mA.

3. Perform the calibration of 20 mA.

a) Select Enter 20 mA Fixed Current Mode to set the analog out to 20 mA.

b) Measure the analog output with the ampere meter.

c) In the 20 mA Measured Current box, enter the measured current.

d) Select Write to device.

e) Select Calibrate 20 mA.

f) Measure the analog output with the ampere meter and verify it is within
20±0.01 mA.

4. Select Exit Fixed Current Mode.

7.5.6 View input registers
Measured data is continuously stored in the input registers. By viewing the contents of the
input registers, expert users can check that the transmitter works properly.

Procedure

1. Under Menu, select Diagnosis → Read Input Registers.

2. In the Input Reg. Number box, enter the input register to start reading from.

The default start register is 5100 (Alert Summary).

3. Select Write to device.
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4. Select Read to device (not required in Rosemount IO-Link Assistant).
Five registers will be read, starting from the selected number.

7.5.7 View holding registers
The holding registers store various transmitter parameters, such as configuration data,
used to control the measurement performance.

Procedure

1. Under Menu, select Diagnosis → Read Holding Registers.

2. In the Holding Reg. Number box, enter the holding register to start reading from.

3. Select Write to device.

4. Select Read to device (not required in Rosemount IO-Link Assistant).
Five registers will be read, starting from the selected number.

7.5.8 Edit holding registers
The holding registers store various transmitter parameters, such as configuration data,
used to control the measurement performance.

Prerequisites

Note
Do not use holding registers to configure the transmitter unless you are qualified. This
dialog is mainly used for service purposes and for advanced configuration.

Procedure

1. Unlock the write protection of the holding registers.

a) Under Menu, select Diagnosis → Write Holding Registers → Write Holding
Registers (Word).

b) In the Register Number box, enter 0.

c) In the Value (Word) box, enter 1234.

d) Select Write to device.

2. To edit a holding register value:

a) Under Write Holding Registers (Float) or Write Holding Registers (Word),
enter the register number and the corresponding value.

b) Select Write different values to device (Write to device in Rosemount IO-
Link Assistant).

3. Verify the written value by reading the holding register number.

4. Perform a device reset to write protect the holding registers.

Related information

Perform a device reset

Reference Manual Service and troubleshooting
00809-0100-4480 May 2021

Reference Manual 69



7.6 Service support
To expedite the return process outside of the United States, contact the nearest Emerson
representative.

Within the United States, call the Emerson Instrument and Valve Response Center using
the 1-800-654-RSMT (7768) toll-free number. This center, available 24 hours a day, will
assist you with any needed information or materials.

The center will ask for product model and serial numbers, and will provide a Return
Material Authorization (RMA) number. The center will also ask for the process material to
which the product was last exposed.

 CAUTION

Individuals who handle products exposed to a hazardous substance can avoid injury if they
are informed of and understand the hazard. Returned products must include a copy of the
required Safety Data Sheet (SDS) for each substance.

Emerson Instrument and Valve Response Center representatives will explain the additional
information and procedures necessary to return goods exposed to hazardous substances.
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A Specifications and reference data

A.1 Performance specifications

A.1.1 General

Reference conditions
• Measurement target: Stationary metal plate, no disturbing objects

• Temperature: 59 to 77 °F (15 to 25 °C)

• Ambient pressure: 14 to 15 psi (960 to1060 mbar)

• Relative humidity: 25-75%

• Damping: Default value, 2 s

Instrument accuracy (under reference conditions)
±0.08 in. (±2 mm)(1)

Repeatability
±0.04 in. (±1 mm)

Ambient temperature effect
±0.04 in. (±1 mm)/10 K

Sensor update rate
Minimum 1 update per second (typically 5 updates per second)

Maximum level rate
200 mm/s

A.1.2 Measuring range

Maximum measuring range
33 ft. (10 m)(2)

(1) Refers to inaccuracy according to IEC 60770-1 when excluding installation dependent offset. See the IEC 60770-1 standard
for a definition of radar specific performance parameters and if applicable corresponding test procedures.

(2) Note that a combination of adverse process conditions, such as heavy turbulence, foam, and condensation, together with
products with poor reflection may affect the measuring range.
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Accuracy over measuring range
Figure A-1 illustrates the accuracy over measuring range at reference conditions.

Figure A-1: Accuracy Over Measuring Range
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A.1.3 Environment

Vibration resistance
• 2 g at 10-1000 Hz according to IEC 61298-3, level “field with general application”

Electromagnetic compatibility (EMC)
• EMC Directive (2014/30/EU): EN 61326-1

• NAMUR recommendations NE21 (only 4-20 mA output)

Pressure Equipment Directive (PED)
Complies with 2014/68/EU article 4.3

Radio approvals
• Radio Equipment Directive (2014/53/EU): ETSI EN 302 372 and EN 62311

• Part 15 of the FCC Rules

• Industry Canada RSS 211
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Related information

Product certifications

A.2 Functional specifications

A.2.1 General

Field of application
Continuous level measurements in the hygienic industry.

Minimum dielectric constant
2

Measurement principle
Frequency Modulated Continuous Wave (FMCW)

Frequency range
77 to 81 GHz

Maximum output power
3 dBm (2 mW)

Internal power consumption
< 2 W (normal operation at 24 Vdc, no outputs)

< 3.6 W (normal operation at 24 Vdc, digital and analog outputs active)

Humidity
0 - 100% relative humidity, non-condensing

Turn-on time
< 15 s(3)

A.2.2 Outputs
The transmitter provides two configurable outputs:

Output 1 Digital output / IO-Link mode

Output 2 Digital output or active 4-20 mA analog output

(3) Time from when power is applied to the transmitter until performance is within specifications.
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A.2.3 Digital output
Switching signal for high and low level limits (using the same pin)

Output type
PNP/NPN configurable

Switching function
Normally open

Permanent current rating
< 50 mA

Maximum voltage drop
2.5 V

A.2.4 4-20 mA analog output

Load limitations
Maximum loop resistance is determined by the voltage level of the external power supply:

Maximum Loop Resistance = 43.5 × (External Power Supply Voltage - 18) + 600 Ω

Figure A-2: Load Limits
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Analog signal on alarm
The transmitter automatically and continuously performs self-diagnostic routines. If a
failure or a measurement error is detected, the analog signal will be driven offscale to alert
the user. High or low failure mode is user-configurable.

Table A-1: Signal on Alarm

Level Custom levels NAMUR NE43 (default)

Low 3.5 to 4.0 mA 3.5 mA (NAMUR ≤ 3.6 mA)

High 20.0 to 22.5 mA 21.5 mA (NAMUR ≥ 21.0 mA)

Analog saturation levels
The transmitter will continue to set a current that corresponds to the measurement until
reaching the associated saturation limit (and then freeze).

Table A-2: Saturation Levels

Level Custom levels NAMUR NE43 (default)

Low 3.5 to 4.0 mA 3.8 mA

High 20.0 to 22.5 mA 20.5 mA

A.2.5 IO-Link specifications

IO-Link revision
1.1

Transfer type
COM2 (38.4 kBaud)

SIO mode
Yes

IO-Link master port
Class A

Minimum cycle time
6 ms

Reference Manual Specifications and reference data
00809-0100-4480 May 2021

Reference Manual 75



A.2.6 Configuration

IO-Link configuration tools
Examples:

• Rosemount IO-Link Assistant (available as accessory)

• FDT® frame applications, e.g. PACTware

Damping
User selectable (default is 2 s, minimum is 0 s)

Output units
• Level: in., m

• Temperature: °F, °C

• Signal strength: mV

Output variables

Variable 4-20 mA DO1 and DO2 Digital, service
tools using
IODD

IO-Link PDIn
(to the PLC)

Level ✓ ✓ ✓ ✓

Distance (ullage) N/A N/A ✓ N/A

Electronics temperature N/A N/A ✓ N/A

Signal strength N/A N/A ✓ N/A

A.2.7 Process pressure
-15 to 116 psig (-1 to 8 bar)

Atmospheric pressure at temperatures below -4 °F (-20 °C)

A.2.8 Temperature limits

Process temperature

With adapter

-4 to 302 °F (-20 to 150 °C)

Without adapter

-40 to 302 °F (-40 to 150 °C)
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Ambient temperature
-40 to 176 °F (-40 to 80 °C)

The ambient temperature limits may be further restricted by the process temperature as
described by Figure A-3.

Figure A-3: Ambient Temperature vs. Process Temperature

A

B

104 (40)

176 (80)

302

(150)

176

(80)

-40

(-40)

-40 (-40)

A. Ambient temperature °F (°C)
B. Process temperature °F (°C)

Storage temperature
-40 °F to 194 °F (-40 °C to 90 °C)

A.3 Physical specifications

A.3.1 Material selection
Emerson provides a variety of Rosemount products with various product options and
configurations including materials of construction that can be expected to perform well in
a wide range of applications. The Rosemount product information presented is intended
as a guide for the purchaser to make an appropriate selection for the application. It is the
purchaser’s sole responsibility to make a careful analysis of all process parameters (such as
all chemical components, temperature, pressure, flow rate, abrasives, contaminants,
etc.), when specifying product, materials, options, and components for the particular
application. Emerson is not in a position to evaluate or guarantee the compatibility of the
process fluid or other process parameters with the product, options, configuration or
materials of construction selected.
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A.3.2 Transmissible Spongiform Encephalopathy (TSE)
declaration
This declaration is applicable to the Rosemount 1408H when fitted with the hygienic
adapter and O-ring.

Emerson certifies no process wetted components used in this product contain substances
of animal origin. Materials used in the production or processing of wetted components for
this product meet the requirements stated in EMA/410/01 Rev. 3 and ISO 22442-1:2015.
Wetted components in this product are considered free of TSE.

Related information

Materials of construction

A.3.3 Food and Drug Administration (FDA) declaration
When fitted with the hygienic adapter and O-ring, the process wetted components used in
this product conform to FDA 21CFR110, Subpart C: Food and Drug Administration -
Current Good Manufacturing Practice In Manufacturing, Packing, Or Holding Human Food.

Related information

Materials of construction

A.3.4 Housing and enclosure

Materials
Polished stainless steel 316L (EN 1.4404)

Transmitter weight
1.1 lb (0.5 kg)(4)

Ingress protection
• IP66/68(5)/69 (IEC 60529)

• IP6K9K (ISO 20563:2013)

• NEMA® 4X

The stated ingress protection only applies when plugged in using a suitable M12
connector that has the appropriate ingress protection.

(4) Adapter not included.
(5) IP68 at 9.8 ft. (3 m) for more than 30 minutes.
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A.3.5 Surface finishes
Process wetted parts

• Ra < 30 μ-in. (0.76 μ-m) for polymeric parts

• Ra < 16 μ-in (0.4 μ-m) for metallic parts

Non-wetted parts

• Ra < 30 μ-in. (0.76 μ-m) for stainless steel housing

A.3.6 Process connection
ISO 228/1-G1 thread with a wide choice of hygienic adapters

A.3.7 Material exposed to tank atmosphere
With adapter

• PTFE sealing: PTFE fluoropolymer

• Adapter: 316L (EN 1.4435)

• Hygienic O-ring: EPDM or FKM

Without adapter

• PTFE sealing: PTFE fluoropolymer

• O-ring: FVMQ

• G1 thread: 316L (EN 1.4404)

• Profile ring: FKM
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A.4 Dimensional drawings
Figure A-4: Rosemount 1408H

Ø 2.32 (59) 2.99 (76)

4.76
(121)
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B

A C

A. ISO 228/1-G1 thread
B. M12 connector (A-coded)
C. Hygienic process connection adapter

Dimensions are in inches (millimeters).

See also the Rosemount Hygienic Process Connection Adapters Type 1 Drawing.
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B Product certifications
Rev 1.2

B.1 European directive information
A copy of the EU Declaration of Conformity can be found at the end of the Quick Start
Guide. The most recent revision of the EU Declaration of Conformity can be found at
Emerson.com/Rosemount.

B.2 UK regulation information
A copy of the UKCA Declaration of Conformity can be found at the end of the Quick Start
Guide. The most recent revision of the UKCA Declaration of Conformity can be found at
Emerson.com/Rosemount.

B.3 Ordinary location certification
As standard, the transmitter has been examined and tested to determine that the design
meets the basic electrical, mechanical, and fire protection requirements by a nationally
recognized test laboratory (NRTL) as accredited by the Federal Occupational Safety and
Health Administration (OSHA).

Certificate 80031621

Standards CAN/CSA-C22.2 No. 61010-1-12, UL Std. No. 61010-1

Markings 18-30 VDC, 3.6W

The device may only be powered by a power supply unit with a limited energy electric
circuit max. 30 Vdc output in accordance with CAN/CSA-C22.2 No. 61010-1-12 / UL Std.
No. 61010-1 (3rd Edition) chapter 6.3.1/6.3.2 and 9.4 or class 2 according to CSA 223/UL
1310.

B.4 Telecommunication compliance
Measurement principle

Frequency Modulated Continuous Wave (FMCW), 80 GHz

Maximum output power

3 dBm (2 mW)

Frequency range

77 to 81 GHz
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TLPR (Tank Level Probing Radar)

TLPR (Tank Level Probing Radar) equipment are devices for measurement of level in a
closed space only (i.e metallic or reinforced concrete or fiberglass tanks, or similar
enclosure structures made of comparable attenuating material). Rosemount 1408H is
TLPR device. Hardware Version Identification Number (HVIN) is 1408T.

B.5 FCC
Note: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the following
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

FCC ID K8C1408T

B.6 IC
This device complies with Industry Canada’s licence-exempt RSS standard. Operation is
subject to the following conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, including interference that may
cause undesired operation.

3. The installation of the TLPR device shall be done by trained installers in strict
compliance with the manufacturer’s instructions.

4. The use of this device is on a “no-interference, no-protection” basis. That is, the
user shall accept operations of high-powered radar in the same frequency band
which may interfere with or damage this device. However, devices found to
interfere with primary licensing operations will be required to be removed at the
user’s expense.

5. This device shall be installed and operated in a completely enclosed container to
prevent RF emissions, which can otherwise interfere with aeronautical navigation.

6. The installer/user of this device shall ensure that it is at least 10 km from the
Dominion Astrophysical Radio Observatory (DRAO) near Penticton, British
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Columbia. The coordinates of the DRAO are latitude 49°19′15″N and longitude
119°37′12″ W. For devices not meeting this 10 km separation (e.g., those in the
Okanagan Valley, British Columbia,) the installer/user must coordinate with, and
obtain the written concurrence of, the Director of the DRAO before the equipment
can be installed or operated. The Director of the DRAO may be contacted at
250-497-2300 (tel.) or 250-497-2355 (fax). (Alternatively, the Manager, Regulatory
Standards, Industry Canada, may be contacted.)

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils
radio exempts de licence. L'exploitation est autorisée aux conditions suivantes:

1. l'appareil ne doit pas produire de brouillage.

2. l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage
est susceptible d'en compromettre le fonctionnement.

3. L’installation d’un dispositif TLPR doit être effectuée par des installateurs qualifiés,
en pleine conformité avec les instructions du fabricant.

4. Ce dispositif ne peut être exploité qu'en régime de non-brouillage et de non-
protection, c'est-à-dire que l'utilisateur doit accepter que des radars de haute
puissance de la même bande de fréquences puissent brouiller ce dispositif ou
même l'endommager. D'autre part, les capteurs de niveau qui perturbent une
exploitation autorisée par licence de fonctionnement principal doivent être enlevés
aux frais de leur utilisateur.

5. Un dispositif visé comme TLPR doit être installé et exploité dans un réservoir
entièrement fermé afin de prévenir les rayonnements RF qui pourraient autrement
perturber la navigation aéronautique.

6. La personne qui installe/utilise ce capteur de niveau doit s'assurer qu'il se trouve à
au moins 10 km de l'Observatoire fédéral de radioastrophysique (OFR) de Penticton
en Colombie-Britannique. Les coordonnées de l'OFR sont: latitude N 49° 19′ 15″,
longitude O 119° 37′ 12″. La personne qui installe/utilise un dispositif ne pouvant
respecter cette distance de 10 km (p. ex. dans la vallée de l'Okanagan [Colombie-
Britannique]) doit se concerter avec le directeur de l'OFR afin d’obtenir de sa part
une autorisation écrite avant que l'équipement ne puisse être installé ou mis en
marche. Le directeur de l'OFR peut être contacté au 250-497-2300 (tél.) ou au
250-497-2355 (fax). (Le Directeur des Normes réglementaires d'Industrie Canada
peut également être contacté).

Certificate 2827A-1408T

B.7 Radio Equipment Directive (RED) 2014/53/EU
and Radio Equipment Regulations S.I.
2017/1206
Rosemount 1408H complies with ETSI EN 302 372 (TLPR) and EN 62311.

TLPR (Tank Level Probing Radar)

The device must be installed in closed tanks. Install according to requirements in
ETSI EN 302 372 (Annex E).
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Performance under the influence of an interferer signal

For the receiver test that covers the influence of an interferer signal to the device, the
performance criterion has at least the following level of performance according to ETSI TS
103 361 [6].

• Performance criterion: measurement value variation Δd over time during a distance
measurement

• Level of performance: Δd ≤ ± 2 mm

B.8 Radio/EMC Republic of Korea
Registration
number

R-R-Rtr-1408

B.9 Additional certifications

B.9.1 3-A®

Certificate
Authorization
Number

3626

Standard 3-A Sanitary Standards for Number 74-07 (Sensors and Sensor Fittings
and Connections)

B.9.2 Materials of construction
The hygienic approvals and certificates of the transmitter rely upon the following materials
used in its construction:

Table B-1: Product Contact Surfaces

Item Material Compliant with

PTFE sealing PTFE fluoropolymer 21 CFR 177.1550

EC 10/2011

TSE/BSE Free

Hygienic adapter Stainless steel 300 series TSE/BSE Free

Hygienic adapter O-ring FKM or EPDM 21 CFR 177.2600

TSE/BSE Free
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Table B-2: Nonproduct Contact Surfaces

Item Material

Housing Stainless steel 300 series

Bushing Stainless steel 300 series

Plug Stainless steel 300 series

Adapter seal FKM

Electrical connector Contact pins in gold plated brass

Housing in plastics (PA)

Seal in FKM
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C Configuration parameters

C.1 Menu tree
Figure C-1: Parameter

Menu > Parameter Basic Setup

OUT1

OUT2*

Engineering Units

Digital Output 1

OUT1 Configuration

Reference Height

OUT2 Configuration

Write Protection

Digital Outputs P-n

Geometry Reference Height

Advanced Calibration Offset

Upper Null Zone

Bottom Offset

Negative Level

Measurement Recovery Time

Damping Value

General Threshold

Service Tools

Maintenance Device Reset

Restore Factory Settings

Advanced Setup

Simulation

Application Mode

Analog Out Calibration

High Alarm

SP1-High Alarm Set Point

SP2-Low Alarm Set Point

Analog Output 2 Upper Range Value (20 mA)

Lower Range Value (4 mA)

Alarm Mode

Low Alarm

Analog Alarm Limits High Alarm Value

High Saturation Value

Low Saturation Value

Low Alarm Value

DO1 Advanced Alarm configuration

SP1-Hysteresis High Alarm

SP2-Hysteresis Low Alarm

Alarm On Delay

Alarm Off Delay

* Contains the same sub-menus as OUT1 when the OUT2 is configured for digital output.
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C.2 Basic setup

C.2.1 Engineering units
Sets the unit of measure for length and temperature.

Option Length unit Temperature unit

Metric m °C

Imperial inch °F

After appropriate units have been selected, all configuration parameters and transmitter
variables will be expressed in these units.

C.2.2 Reference height
Distance between the Device Reference Point and Zero Level.

Figure C-2: Reference Height

A

B

C

A. Device Reference Point
B. Reference Height
C. Zero Level

Ensure the Reference Height is set as accurate as possible. The transmitter measures the
distance to the product surface and subtracts this value from the Reference Height to
determine the level.

Related information

Enter the reference height
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C.2.3 OUT1 configuration
Output 1 provides a digital output for high/low level limits and IO-Link communication.

Table C-1: Options for OUT1

Option Description

Disabled N/A

Digital Output Normally Open Switching signal for high and low level limits

If set to Disabled, the transmitter may still be operated in IO-Link mode.

Related information

Digital output

C.2.4 OUT2 configuration
Output 2 can perform one of these functions:

Table C-2: Options for OUT2

Option Description

Disabled N/A

Analog Output 4-20 mA Analog 4-20 mA signal proportional to the level

Digital Output Normally Open Switching signal for high and low level limits

Related information

Digital output
Analog output

C.2.5 Digital output P-n
The output polarity for the switching outputs (PnP or nPn).

C.2.6 Write protection
The transmitter can be software write protected to prevent unintentional configuration
changes.

C.3 Digital output

C.3.1 Alarm configuration

High alarm
Enable or disable the high level alarm (overfill alarm).
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Figure C-3: Example - High Alarm
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Low alarm
Enable or disable the low level alarm (dry run alarm).

Figure C-4: Example - Low Alarm
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A. Level
B. Time
C. SP2 - Hysteresis low alarm
D. SP2 - Low alarm set point

Alarm set points

SP1 - High alarm set point

If the measured level is above this set point, the digital output is set to alarm state.

SP2 - Low alarm set point

If the measured level is below this set point, the digital output is set to alarm state.

Hysteresis
The hysteresis is a buffer zone so the alerts do not toggle on and off when the
measurement value fluctuates around the alarm limit. The alarm is set when the value
exceeds the alarm limit. The alarm is then cleared when the value falls outside the
hysteresis zone.
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SP1 - Hysteresis high alarm

Hysteresis zone for the high alarm.

SP2 - Hysteresis low alarm

Hysteresis zone for the low alarm.

Alarm delays

Alarm on delay

The time delay for when the digital output transfers from normal to alarm state.

Alarm off delay

The time delay for when the digital output transfers from alarm state to normal.

Figure C-5: Example - High Alarm with Alarm Delays
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C. SP1 - High alarm set point
D. SP1 - Hysteresis high alarm
E. Alarm on delay
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Options for alarm on delay
Table C-3: Alarm On Delay

Option Description

Always Alarm on delay is always used.

Lost surface Alarm on delay is used only for lost surface alarms. This may be useful in
applications when there are small and local rapid level changes caused by
surface turbulence.

Hardware faults and measurement values that exceed the alarm set
points will trigger alarm without any delay.
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Figure C-6: Behavior of the Alarm On Delay
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C.4 Analog output

C.4.1 Upper/lower range value
Enter the range values that correspond to the analog output values 4 and 20 mA. In
normal operation, the transmitter will drive the output in response to level from the lower
to upper saturation points.

Note
The 20 mA point should be set below the reduced accuracy zone at the top of the tank.
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Figure C-7: Example of Range Value Settings
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A. Reduced accuracy zone
B. 100% (20 mA)
C. Zero Level
D. Level measurement range 0-100%
E. 0% (4 mA)

Related information

Accuracy over measuring range

C.4.2 Alarm mode
The transmitter automatically and continuously performs self-diagnostic routines. If a
failure or a measurement error is detected, the transmitter drives the output to selected
alarm limit (high or low).

C.4.3 Analog alarm limits

High/low alarm value
The high/low alarm current for the analog output when the device enters the alarm mode.

Related information

Analog signal on alarm

High/low saturation value
The device will continue to set a current that corresponds with the measurement until
reaching the upper/lower limit (and then freeze).
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Related information

Analog saturation levels

C.5 Geometry

C.5.1 Advanced

Calibration offset
Difference between surface distance measured by transmitter and the same distance
measured by, for example, hand-dipping with a measurement tape. A positive Calibration
Offset value will increase the presented level value.

Figure C-8: Calibration Offset
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A. Positive Calibration Offset value
B. Negative Calibration Offset value
C. Reported level
D. Actual level

Upper null zone
The Upper Null Zone defines how close to the transmitter's reference point a level value is
accepted. You can extend this value to block out disturbing echoes close to the antenna,
for example from the tank nozzle.

Note
Make sure the 20 mA value is below the Upper Null Zone. Measurements are not
performed within the Upper Null Zone (UNZ).

Related information

Change the upper null zone
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Bottom offset
The Bottom Offset is defined as the distance between Zero Level and the tank bottom. The
default value is zero.

If the Zero Level is not located at the tank bottom, then enter a Bottom Offset. It is needed
for the transmitter to know the position of the tank bottom.

Figure C-9: Bottom Offset
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A. Device Reference Point
B. Reference Height
C. Zero Level
D. Bottom Offset

Negative level
If Bottom Offset is greater than zero, the level value can be negative. This parameter
determines if the shown level value can be negative or zero.

Table C-4: Negative Level

Option Description

Equals zero When this setting is selected and the product surface is at or below Zero
Level, the level measurement output will be zero.

Allowed Negative level values are allowed.
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C.6 Advanced setup

C.6.1 Measurement recovery time
The Measurement Recovery Time (Echo Timeout) parameter controls the maximum time
from when measurement is lost (e.g. due to process conditions such as foam or
turbulence) until it is annunciated. If measurement is recovered within the time specified
by this parameter, then it will not be annunciated.

C.6.2 Damping value
This parameter defines how fast the transmitter reacts to a change of the level value (step
response). The default value is 2 seconds.

A high value makes the level reading steady, while a low value allows the transmitter to
respond to rapid level changes (but the presented level value may be less steady).

C.6.3 General threshold
The general threshold is used to filter out noise and disturbing echoes from the product
surface echo. The transmitter uses certain criteria to decide which type of echo peak that
is detected. Only echoes above the general threshold might be considered the product
surface.

Figure C-10: Threshold Principle
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Related information

Adjust the general threshold
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